
CSG Members
Member Charge Application

Micros Integration Functionality

3700, 8700, 9700

Software Version 6.1g
Contact and Assistance

For assistance with installation or other issues, start by contacting the Micros dealer or organization that sold you this application.
Should additional direct assistance be required, Beyond POS, Inc. may be contacted directly at:

864-284-6028  between 9:00 am to 5:00 pm EST.  

Beyond POS makes no guarantees that a representative will be available during those hours nor does Beyond POS guarantee a particular response time.   Support calls to Beyond POS may be subject to Beyond POS’s hourly support charges unless Beyond POS decides otherwise.  However, any applicable fees will be stated clearly in advance.
New In Version
Version 6.2 (Not released yet)
1. Credit limits based on meal count have been added.   

For example, this allows a member to have limits like:

25 meals per month

2 Meals per day


3 meals per day, one each Breakfast, Lunch, Dinner (specific, preset time ranges)

A “Meal” is a charge to one’s account.  Voided charges are subtracted from the count, positive charges are added to the count.  This would not be appropriate for a situation where one could make 3 separate charges within 5 minutes and have it count as 1 meal.
Version 6.1d
1. 3700 support for Member Pictures is available.  BMP or JPG files can be stored on an accessible server with the Member Number as the file name (1234.bmp).   Instead of displaying the members’ names, the user will be presented with pictures of matching members for confirmation.   This can be turned on/off by workstation.  WS4/5 and Win32 workstations are supported.  There are some image file size restrictions.

2. “Loyalty” functionality has been added.  This is minimalist.  Upon Final Tender, the check totals (itemizers, tax, service charge total, discount total, etc) are stored.  This is the same basic information that is send to a PMS in a room charge.  See the next 2 items for more information.

The “Spending” report(s) can then be used to see spending totals by Account.

3. A Blind Account Number capture Tender function has been added. This allows the user to enter a member id (tax id, or some other kind of ID).  A $0 tender is added to the check with this number as reference.  Upon Final Tender, this number is used to post the loyalty transaction to our database.
4. A validating Account Number capture Tender function has been added. This allows the user to enter an account number.  If it is a valid member, a $0 tender is added to the check with this number as reference.  Upon Final Tender, this number is used to post the loyalty transaction to our database.

Apart from Loyalty reporting, this function can also be used to validate tax numbers for tax exempt transactions.

5. Support for meal allowance amounts or monthly minimum amounts was added.  This is for printing relevant information on chits, not stopping charges.

Version 5.3e
1. Corrected several bugs.

2. Changed csg_reports.exe to use local printer definitions instead of one printer definition stored globally so that separate printers can be selected for different PCs running the reports program.

3. Simplified the installation process.

Version 5.3
4. Added Store tracking for transactions and reports.
5. SQL Server install no longer comes with the database.  The install scripts create and build the shell database.

6. Corrected issues with reporting of Value Card redemptions and add-values.

7. Modified how the workstations look up their current date.

8. Added stronger database user / password encryption.
9. Added option to trim leading 0s from card/badge numbers at the workstation to allow account numbers without leading zeros in the database.

10. Added option to apply card number start position and length to manually entered numbers, to allow barcoded cards to parse properly.

Upgrading from previous versions:


Contact Beyond POS for assistance.

Version 5.0
1. Changed to support MSSQL database.  

Upgrading to Version 5.0:


Due to the numerous incompatibilities between MSSQL and Sybase (and even Access), upgrading will require installation of the shell “bposmembers” database and manual reentry of parameters.   Moving accounts, cards, and transactions is left as an exercise to the user, or may be contracted through Beyond POS, inc.

Version 4.9
1. Added Inquire w/Print key to allow balance inquire to print a chit.  Previously the inquire only displayed resuts.

2. Added support for more than 2 Account Charge tenders.   

3. Added support for “account restrictions” which define ranges of account numbers that are allowed for each account tender.

Version 4.3
1. Support is provided for partial payments to an Account 1 or Account 2 charge.  Partial Payment means that if there is insufficient credit available on an account, the user can elect to use that amount without re-entering the charge.  However, it is important that a charge tip NOT be linked to these tenders when using partial payments.  Charge tips must be applied manually before entering one of these payments when using partial payments.

2. Previously, only the period-to-date total printed on the receipt.  Support has been added to allow the following to print on the receipts:

a. Available Credit for the current period

b. Credit Used for the current period

c. Both a. and b.

3. Support has been added to allow the Import process to use the import process to update only card balances or account credit limits.  Use of this feature precludes use of importing full account or card setups.

Upgrading to version 4.3 from 4.2 requires adding the following columns to the csg_member_params table:

Receipt_Format
Integer 
Default = 0


ImportBalanceOnly
Integer
Default = 0
Introduction

Overview

This application provides Employee Charge and Value Card functions for the Micros 3700, 8700, and 9700. The following basic functionality is included:

1.
Charge Accounts:  An account could be an employee badge number, a condo owner room number, a department code (e.g., Pediatrics), or any other unique identifying number.

Charge accounts have “credit limits” per time period.  For example, $50. per month.  You can set up several Micros Tenders for use with a charge account.  Each tender can have its own credit limit per account, and each tender can have its own “period”.  


This application does not generate invoices or track receivables (payments).  It is intended to pass the data to another application that does that (Payroll Deductions, QuickBooks, Excel, etc).

2.
Value Cards:  These should not be used as full-bodied, high volume, gift cards.   These are cards that have cash value added, which can be paid for on a Micros terminal, or via back-office.  These cards may be used as payment in Micros until the balance runs out.  For example, each member of a convention group could be given $20. value card in lieu of meal coupons.


Currently there is 1 value card tender in Micros.

3.
Loyalty Tracking: It is possible to use this system to track spending totals by account number.  Refer to the Spending reports and configuration for details.

4.
Import:  Accounts can be imported regularly manually or automatically.  For example, a list of active employees could be imported daily for payroll deduction use.

5.
Export:  Charge information can be exported manually or automatically to ascii files.  For example, a payroll import file could be exported at the end of each pay period.

6.
File Transfer:  A utility to perform FTP of import and/or export, or Email transfer of export files, is included.

7.
It is possible to have a single database shared by multiple locations.  
For the 3700, the data this interface can be stored in the Micros database.  For the 8700 and 9700, the data for this interface is stored in an SQL Server (or MSDE) database.  8700 systems will require that the back-of-house applications and DB be located on a Windows PC connected to the 8700 via tcp/ip.  The 3700 and 9700 systems can run the back-of-house apps and db on the Micros server.
Architecture 

The following is a diagram of the components of this interface.  The bposmembers database (or 3700 database tables) is created during the install   Items in bold/italics are components included with the interface. Other items are native Micros components.
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Operations

Account Charges
Within Micros, an Account/Member Charge is set up as a payment type, like Cash, Visa, etc.  But, the Account Charge payment is linked to this interface.  When an employee charge is performed, the interface looks up the Account number or name from a database table and checks the employee’s account settings.   If Photos are enabled, the photo is also obtained and displayed for confirmation.
Inquires

To look up an account by name or number:


1.
Press the Account Inquire key.


2.
The system will prompt for an Account number or name:





Enter the Account Number or Name

3. Swipe the ID card or enter the number or partial name, and press the Enter or Yes key.   

* Manual Entry may be restricted thereby requiring a card swipe.


4.
The system will look for a match in the Account File.



If your entry results in a large number of matching Employees, you will be warned that there are too many matches, and only the first 10 will be displayed.


5.
If Photos are not enabled, a window similar to the following one will be displayed:





      Selection

Number
 
Name

 




1.

12345

Mark Smith









2.

12346

Suzie Smith









3.

13456

Ralph Smith






6.
If Photos are enabled, The Photo(s) will be displayed and the user will scroll thru the pictures and select the correct person:

Account Payments

To charge to an Account:


1.
Press the Account Charge key.


2.
The system will prompt for a Account number or name:





Enter the Account Number or Name

4. Swipe the ID card or enter the number or partial name, and press the Enter or Yes key.   

* Manual Entry may be restricted thereby requiring a card swipe.


5.
The system will look for a match in the Account File.



If your entry results in a large number of matching Employees, you will be warned that there are too many matches, and only the first 10 will be displayed.


6.
A window like the following one will be displayed:





      Selection

Number
 
Name

 




1.

12345

Mark Smith









2.

12346

Suzie Smith









3.

13456

Ralph Smith







If only one Account matches the operator’s entry, then a confirmation prompt will be displayed. Press Enter/Yes to use that Account.  Press Clear/No to cancel.



If several Account matched the entry (For example, “SMITH”, or several people on one Account number), the system will list the matches and prompt to choose the correct Account.  Enter the selection number and press Enter/Yes or press Clear/No to exit.


.
If Photos are enabled, The Photo(s) will be displayed and the user will scroll thru the pictures and select the correct person:


7.
When the correct Account is selected, the system will write the details of the sale to the transaction  file, and then complete the payment on the Micros system.



The charge will appear on the check similar to the following example:





check details




…




Employee: 12345




Suzie Smith




   Employee Charge
12.25




…




more check details



A chit will print that looks similar to the following example:








     
        Cafateria




                 Employee Charge




           10/02/2002
10:23




------------------------------------------------




Employee: 12345




Suzie Smith




   Current Charge

$  1.24




    Current Period

  12.40





Card Capture Payments

If you are using this application to validate accounts, you can do that using and Account Tender with a $0.00 amount.  For example, if each account is a Tex ID, then the Account Tender can be a Tax Exempt tender.  When the Tax ID is entered, if it exists, the tender will be done, making the check tax exempt.


If you are using this application to capture spending information for accounts, then the Account Tender will be a $0.00 tender that simply validates and captures the Account number. 

In any case, the process is exactly the same as making an Account Charge, but the payment amount will be $0.00.

If you are capturing spending information, then at “Final Tender”, the check totals will be stored as a transaction for later reporting.

Blind Card Capture Payments

If you are using this application to capture account information for later use in Spending Reports, but the account numbers are not stored in this application, you can use the Blind Capture tender. 

This will work exactly like the Card Capture payments, but no validation is performed.  

This could be used, for example, to capture spending totals for tax IDs where any tax ID could be swiped, and they are not to be validated.

Resident Charge (Medical Residents)
Within Micros, a Resident Charge is set up as a payment type, like Cash, Visa, etc.  But, the Resident Charge payment is linked to this interface.

When a Resident charge is performed, the interface looks up the Employee number or name from a database table.  

To charge to a Resident Tender:


1.
Press the Resident Charge key.


2.
The system will prompt for an Employee number or name:





Enter the Account Number or Name

3. Swipe the employee card, or enter the number, or partial name, and press the Enter or Yes key.   


4.
The system will look for a match in the Account File.



If your entry results in a large number of matching Account, you will be warned that there are too many matches, and only the first 10 will be displayed.


5.
A window like the following one will be displayed:





      Selection

Number
 
Name

 




1.

12345

Mark Smith







If only one Account matches the operator’s entry, then a confirmation prompt will be displayed. Press Enter/Yes to use that Account.  Press Clear/No to cancel.



If several Accounts matched the entry (For example, “SMITH”, or several people on one Employee number), the system will list the matches and prompt to choose the correct Account.  Enter the selection number and press Enter/Yes or press Clear/No to exit.



If the configuration is set to not allow manual entry, then the charge will only be allowed if the card has been swiped.

5. When the correct Account is selected, the system will write the details of the sale to the transaction file, and then complete the payment on the Micros system.



The charge will appear on the check similar to the following example:





check details




…




Employee: 12345




Suzie Smith




   Resident Charge
3.25




…




more check details



A chit will print that looks similar to the following example:








     
        Cafateria




                 Resident  Charge




           10/02/2002
10:23




------------------------------------------------




Employee: 12345




Suzie Smith




   Current Charge

$  1.24




   Meal Period Total
    3.25

6. Residents can charge up to a pre-defined limit per “period” to the Resident Charge payment.  Periods are defined in the configuration utility.   


Note:  
The “automatic employee charge” feature noted below will work if the Resident Charge “Overage” tender is defined.  This tender is referred to here as the Employee Charge. If this tender is 0, then all the functions here will be the same, except that the automatic employee charge will not be performed.



If the current time is not within one of the 5 predefined time periods, then a message will appear indicating that the resident charge is not allowed at the current time.


If the current charge plus the previous charges for the period do not exceed the allowed limit, then the transaction completes.  

If the current charge plus previous resident charges for the period exceed the limit, then the resident charge will complete for the amount that is left to bring the current period’s charges up to the limit, and the remaining charge is done automatically to an Employee Charge.  When this happens, Micros will show 2 payments.  One for the Resident charge, and one for the Employee charge.  Two chits will print, one for each charge. 

If the employee has already used their limit in the current period, then the amount tendered will be closed to the Employee Charge.

Value Cards

Inquires

To look up a Value Card:


1.
Press the Value Card Inquire Key


2.
The system will prompt for a card number:





Enter Card Number or Swipe the Card 

4. Swipe the Value Card, or enter the number and press the Enter or Yes key.   


5.
The system will look for a match in the Cards File.

6. A chit will print that contains information about the card, like the balance, active dates, and the group number that is associated with the card.

Payments

To charge to a Value Card:


1.
Press the Value Card key.


2.
The system will prompt for a card number:





Enter Card Number or Swipe the Card 

5. Swipe the Value Card, or enter the number and press the Enter or Yes key.   


5.
The system will look for a match in the Cards File.

7. If the card is valid, and there is enough value to cover the amount requested, then the amount will be removed from the card, and the payment will complete in Micros.


If there is no value available on the card, or if the card is not valid, then the Micros payment will be cancelled and alternate payment will be required.


If there is value on the card, but not enough to cover the amount of the payment on Micros, then the amount available will be removed from the card and that amount will be applied to the check in Micros.  Alternative payment will then be required for the remainder of the Micros check. 


The card may be valid for specific dates.  If the card is out of date, then an appropriate message will be displayed. The card may be valid for specific revenue centers.  If the card is not valid in the current revenue center, , then an appropriate message will be displayed.  


7.
When a payment is complete, the payment will show on the Micros check like the following example:






check details




…




1234567890123456




Jones Group




   Value Card

12.25




…




more check details



And, a chit similar to the following will be printed:








Value Card



1/22/2004




1234567890123456




Jones Group




   Current Charge

   
12.25




   Remaining Balance

35.75





Add Value

All Value Cards must be created using the “CSG Members” program.  Once created, additional value may be added to the card from the POS. 

Note: When Adding / Removing value from a card other than by using the card as payment, the Micros User should NEVER use the standard Micros Void functions.  There is one key to add value to a card, and another to remove value from a card (i.e. voiding an add value).


Add Value


1.
Depending on the Micros Configuration, you may need to begin a check.


2.
Press the Card Add Value key.


2.
The system will prompt for a card number.  Swipe or enter the number.


4.
The system will verify that the card exists.  If so, you will be prompted for the amount.  If an amount was entered before pressing the Card Add Value key, that value will be used.


5.
The amount is added to the card’s balance, and a Service Charge will be added to the Micros Check.


Void Add Value


This function normally requires manager auth.  


1.
Depending on the Micros Configuration, you may need to begin a check.


2.
Press the Void Card Add Value key.


2.
The system will prompt for a card number.  Swipe or enter the number.


4.
The system will verify that the card exists.  If so, you will be prompted for the amount.  If an amount was entered before pressing the Card Add Value key, that value will be used.


5.
The amount is removed from the card’s balance, and a Voided Service Charge will be added to the Micros Check for a negative amount.


Note:
On the 3700 system, some versions / hot fixes / service packs contain features that affect voids of Value Cards.  While the process here will work in any case, it is strongly recommended to install the proper service pack / hot fix to obtain the following features in order to take advantage of additional security functions:



SIM Features:





@VOIDSTATUS 
system variable





void_svc 

SIM event

Administrative Information

Installation Overview

The installation process can appear to be tedious.  But, it sounds worse than it is.  Follow these basic steps, and refer to specific sections of the manual for details of each step.  It is likely that the installation will require assistance, particularly if you have never installed it.  Contact Beyond POS, Inc. for assistance as need.
0. Contact Beyond POS for a License Code.  The application uses the MAC Address of the PC on which it is installed.  Any of the MAC addresses can be used.  One that is a stable, Physical adapter should be used.
1. Run the installation executable on the Windows PC on which the MS SQL database will reside (3700 and 9700 can be the Micro server).


For 3700, installation path should be: \csg_members6

For 9700, installation path should be: \ csg_members6

For 8700, installation path on the windows PC should be: \csg_members6

However, ultimately, you can pick any folder you want.

2. Run the “csg_members_batch.exe” program:

a. Run “Administrative->Create DB Tables” (builds the SQL Server DB on the 9700)

b. Run “Administrative->Install Service”
c. On the 9700 or on desktop PCs that are not the 3700 server, 
Run “Administrative->Install BDE”
3. Run the “csg_members.exe” program
a. Enter the db user/password

b. Set the License Code

c. Set the database type

d. File->Save

4. Do the Micros Configuration items.



Interface Record,



Service Charge,



Tenders,



Touchscreens,



Autosequences (automatic imports/exports and period date changes):





For 3700 and 9700: Csg_members_eod.bat, csg_members_eom.bat as needed.




For 8700, no autosequences are required.



Windows Scheduler




For 8700: Csg_members_eod.bat, csg_members_eom.bat as needed




For 3700 and 9700, no scheduler jobs are needed.

5. Copy the isl file.



For 3700, 9700, and 8700: Copy the file “csg.isl” to the appropriate file name in the micros “etc” folder, and/or CAL folder.  

6. Run” CSG_Members.exe” and configure the parameters.  Perhaps even a couple of test accounts / cards.

7. Start the “BPOS Members SIM Connector” service
8. Test it out.

Micros Configuration

Interface Definition

An Interface Record for this interface is used.  Type TCP/IP, SIM Interface, Port 5008 (or other free port.  NOT 5011 or 5009).  Refer to the “BPOS Members SIM Connector” section.   This will require a System Stop and Start if you add a new interface record.  A timeout of 15 - 30 seconds is normally fine.  (However, transactions should only take a second or two)
Tender Media

Several tenders can be used: Account Charge tenders (Employee, Staff, or whatever), Value Cards, and Resident Charge.  

Set each of these tenders to be:

Linked to this SIM Interface.

Do not check “Reference Required”


3700 Key Code: Must match the Object Number.  
Service Charge

To allow adding value to cards from the POS, set up a service charge with these properties:

 
General Tab


Non Tax (usually)


All Menu Levels


3700 Key Code: Must match the Object Number.  

 General Tab


All off except:



Amount




Reference Required


 Discount/Service Tab


All off


** Non Revenue is NOT supported.

Touchscreen Defintion

The following touchscreen keys are used  


Reload (INIT) Parameters


SIM Inquire 10


Diagnostic Card Data Read
SIM Inquire 19 (displays the Track 2 number on the card swiped or scanned).
Account Inquire:



SIM Inquire 1

Account Inquire w/print:


SIM Inquire 4

Rollover Tender Inquire:


SIM Inquire 8

Account Charge: 
Tender Media(s) for this type of charge(s).  Can be several (Employee, Doctor, Department, etc).
Resident Charge:



Sim Inquire 2

Direct Employee Charge: 


Sim Inquire 16

* If you are using the Resident Charge feature, then use this inquire for the touchscreen key that is the Employee Charge that is the “Overage Tender” for the Resident Charges.  For example, if the Payroll Deduct tender is 21, and that’s also the Overage Tender, then if you want the Payroll Deduct tender to also be available without the Resident charge, put this inquire on the touchscreen for Payroll Deduct payments.
Value Card Inquire: 


SIM Inquire 3

Add Value to Card: 


SIM Inquire 14
Void Add Value to Card: 


SIM Inquire 15
Value Card Charge: 


Tender Media for Value Cards

Internal Event, not for touchscreen:

SIM Inquire 6

Tracking Defintion


All tenders are needed in Tracking.


The Add Value Service charge needs to be added to tracking.  Generally, this service charge will need to be subtracted from Net Revenue.  This would be a site-specific issue.

Micros Autosequences


On the 3700 and 9700, these autosequences can be used.  On the 8700, the PC running the database should call these programs from the Windows Scheduler.  It is generally recommended that the Windows Scheduler be used in order to avoid problems that arise when the Autosequencer malfunctions or EOD is not properly completed.

Two sample batch files are included that should be run from the Autosequencer.  These are csg_members_eod.bat and csg_members_eom.bat.  These include the steps listed below.



End-Of-Day programs


An autosequence should be configured that runs the following programs every day. 




Run_csg_members_eod.bat


Generally, this bat file would export any data you want daily, and would import any employees or accounts you want imported daily.  


End-Of-Period programs


An autosequence should be configured that runs the following programs every pay period end.  Note, not all are required, pick the ones you want/need.


Refer to the files:




Run_csg_members_eom.bat


Generally, this bat file will rotate the “period start dates” for accounts, and may export data needed at period_end.


You may need several of these files.  If you have one Account Tender that uses a Monthly credit limit, then you need one of these bat files to run Monthly.  If you have another Account Tender that uses bi-weekly credit limits, then you will need another of these bat files to run bi-weekly, etc.


For example, if you wanted to reset the credit limits weekly, you would run the End-Of-Period program steps for RESET_RECEIPT / RESET_LIMIT every week.


If you wanted to reset the limits for tender 101 weekly, tender 103 monthly, and the value card balances to $100.00 yearly, you would run:


Run_weekly_bat.bat:



RESET_LIMIT  101

Run_monthly_bat.bat:



RESET_RECEIPT 103


Run_yearly_bat.bat:



RESET_BALANCE 100.00

Backups


BACK UP the database…..

On the 9700, this database will be “bposmembers”.  On the 3700, custom tables in the 3700 database are used.
Custom Database and ODBC Setup


1.
Run the CSG_Members_Batch.exe program.

2.
Select Administrative->Create DB Tables


3.
This should create custom tables as needed on the 3700, and should create the bposmembers database on the 9700.


3700 ODBC Data Source:

On the 3700, you do not need to add an ODBC data source.  On individual desktop PCs, you will need to run the Micros “NetSetup” in order to install the correct database drivers, and create the Micros data source.


9700 Configure an ODBC Data source

On the 9700, you will need to create an ODBC Data Source for the bposmembers database.  On individual desktop PCs, you will also need to create an ODBC Data Source that points to the bposmembers database on the server.


a.
Go to the ODBC Data Source Administrator




Start->Settings->Control Panel-> Administrative Options->ODBC Data Sources


b.
Select the “System DSN” tab


c.
Click the “Add” Button


d.
Select “SQL Server” as a provider


e.
Configure options per the following screen shots:
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In the Server field, you should enter the server name and / or database instance to which you added the bposmembers database.  In this example, the server name is csg9700.  This will depend on the specific installation.  However, the Name field MUST contain “bposmembers”.
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On this screen, you MUST set the “With SQL Server Authentication….” Option on.  


The “Create Database Tables” function should have created a “custom” user with a “custom” password for the bposmembers database.  You should try to use that as the user and password.



On this screen, you can use  ”sa” for the Login ID and enter your sa password for the “Password”.  These will only be used to configure this DSN, and will NOT be used by the interface during transactions.
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On this screen, click on the “Change the default database” and select “bposmembers” as the database.
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This screen will probably remain with the defaults.
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When you get to this screen, press the Test Data Source button.  If you don’t see “Test Successful”, then go back and correct the parameters.

Press OK when done.

Configuration Utility (csg_members.exe)
General

The program  …\csg_members5\csg_members.exe is used to configure the interface and perform maintenance, in addition to managing members / employees.

To run the configuration run: 


Windows Start->Programs->CSG Members->CSG_Members

Log in with the custom / custom user.

Initially, use the Configuration->Micros Definitions menu option, and set the following items:

Menu Options
File Menu


Save Configuration
Save all unsaved parameters.


*** This is required at least 1 time to encrypt the database password properly.


Quit
Quit.  Note that some things are saved within the application, and others are not.  Most “parameters” will not be saved until “Save” is used.  Card and account info is saved at various points within their forms.

Enter Data Menu


Enter Accounts
Account (members/employee) entry screen.


Enter Value Cards
Value card entry screen.


Add RVC to all accounts
Allows one to add a revenue center or replace the allowed revenue center list for all Accounts.


Add Tender to all accounts
Allows one to add a tender or replace the allowed tenders list for all Accounts.


Add RVC to all Cards
Allows one to add a revenue center or replace the allowed revenue center list for all Value Cards.

Import/Export Menu


Purge Data
Removes transactions older than the defined length of time on the System configuration tab.

Configuration Menu



All of the available configuration screens.  

CSG_Members Entry Screens

Configure->Micros Definitions


A variety of Micros definitions are kept in this application for efficiency.  This screen contains those items.
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Editing Definitions

If you need to alter the definitions or add new ones, use the navigation bar to add records, or simply edit the existing ones in the Grid.  These definitions are primarily for reporting or chit printing.  You only need the tenders that are used by this interface, but you should include all revenue centers used by this interface.


License Code
License Code 


BD Rotate Hour
On the 9700, this determines when the “business date” changes.  On the 3700, the business date is defined by the Micros Business Date.

Reset Business Date
Change the internal business date to today.  Normally the business date is checked and updated just before each transaction is posted.  But you can also set it here.


PMS Number
This must be the Object Number of the Micros Interface Definition.


PMS Interface Port
This must be the TCP Port you entered in the Micros Interface definition.


Database Type
Valid Choices are only Sybase and SQL Server.

Enter Data->Enter Accounts


This screen is used to enter / change manually entered employee or other charge accounts.  The grid is a scrolled list of accounts.  When the screen is first displayed, press the “Charge Accounts” button.  That will load all the manually entered accounts for edit.  Select an account to enter in the scroll list and double click on the grey button to the left to edit the account.  

To see imported accounts as well, uncheck the “Hide Imported Members” check box.

There are 2 types of accounts.  Charge accounts are typical members/employees.  Value Card Groups are special accounts that will be linked to Value Cards.  You don’t need to have value cards, unless you want them.  If you want any value cards, you must have at least 1 value card account.  Reports will print value card transactions organized by Value Card Groups.  Therefore, if you wanted to have value cards for a group, like “Cutie Pie Birthday” and another for “Toms Wedding”, where each of them got a set of cards for some amount, like $10. or something, you would set up 2 value card groups, and then add cards to each group.
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Operation Desired

Key to push







New Account:

Click on the “+” sign on the lower right of the Grid.  


Save Changes:

Click the Check Mark


Delete Account:
Click the “-“ sign.


Scroll thru accounts
Use the Grid scroll bar


Select one of the accounts to edit



Double Click the account in the grid

Search Accounts
Click the Search Button


Charge Accounts Button

List all Employee Charge Accounts


Value Card Groups Button

List all Group Accounts that will get Cards assigned



Note: 
If the list of items in the grid looks incorrect, press one of the above buttons to refresh the grid.

Edit an Account

After double clicking the account (or inserting a new one), this screen is used to edit the data. Changes here take effect immediately.
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Account Number
Unique number to be used when charging at the workstations.  Alternatively, a Group account identifier.


Group Name
If Value Card Groups was selected, then the group name field is available.  Enter a convenient group name.  


Internal Number
Used for reference.  Possibly a payroll ID or accounting number.

Name, Phone, etc
Name and Account number are required.  Phone and address are not.


Allowed Tenders
This account will only be able to charge to tenders that are listed here, and only up to the amount listed as the limit.


Allowed RVCs
This is a list of revenue centers in which the employee may charge.


Active
If un-checked, and the tender type is defined to “check active”, then the account will not be allowed to charge that micros tender.  For imported accounts, this is used to turn employees off who are not in the imported list.



Do not remove accounts that have done transactions. Instead, de-activate them.


Group Account
If checked, then this account will be flagged as a group account on reports.  This is automatically checked if you checked the “Group Accounts” button on the main screen.

Searching



To search for an account, click Search button.  A field selection window will appear.  Fill in the desired criteria and click “Search Now”.  
[image: image9.png]=loix|

Pler Accaunt Lookup Citeria
> I <

Account Number

Internal Number

Group Name

Name [Fist, Last)
Phone

Address

Ciy, State. Zp .
> I <

Credt Linit

Search Now

Cancel






To Undo a search, simply press the Charge Account” or “Group Account” button.


Enter Data->Enter Value Cards


This screen is used to set up Value Cards.  Value Cards are simply cards assigned to an account.  If an Account is configured as a Value Card Group, then the account may be assigned one or more value cards. Value cards are assigned a balance, and then that balance is reduced each time it is used, and when the balance is 0, the card cannot charge on Micros.  The balance may be increased at the POS, or by changing the balance in this utility.
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Operation Desired
Key to push







New Card:

Click on the “+” sign on the lower right of the Grid.  


Save Changes:

Click the Check Mark


Delete Card:
Click the “-“ sign.


Scroll thru Cards
Use the Grid scroll bar


Select one of the Cards to edit



Double Click on the Card within the Grid


Multi Card Button


This button will clone the currently selected card, and increment the card number for each new card.  The button will prompt for the number of cards, and then that number of new cards will be created, numbered sequentially starting with the current card + 1.  For this function to work, the card must have a numeric card number, and the number must be 15 digits or less.  

Edit Card Details

This screen is used to edit specific Value Cards.   
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Write Off Button
This button is used when the card is to be “Written Off”.  The balance will be transferred to the Write Off balance, and the card will be forever un-usable.  This balance is then available on the Write Off reports.

Group Number
This number MUST be entered and MUST correspond to a valid Group from the Enter Accounts screen.


Card Number
Card number to be used when charging at the workstations.


Card Name
Optional Name associated with the card.


Balance
The available balance on the card.  When the card is first assigned a balance, the balance is recorded as the Initial Balance.  


Active Date
The first day on which the card will be useable at the workstations.  Before this date, message will be displayed on the workstation that the card is not valid today.  


Expire Date
The day on which the card will no longer be useable at the workstations.  On or after this date, message will be displayed on the workstation that the card is not valid today.  


Include RVCs
This is a list of revenue centers in which the card may be used.


Searching


To search for an account, click Search button.  A field selection window will appear.  Fill in the desired criteria.  
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To Undo a search, simply press List Cards button.


Configure->System Parameters
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Max Lookup Matches

Max number of matching employees to display Set to 10 or less.


Days to retain transactions
The number of days to keep transaction details.  This does not affect the Micros transactions.  Minimum is 14 days.


Default report days
The default number of days to include on reports.


Receipt Format
Defines what info to print on the chit.


Use WSID as RVC
Check this on if you want the interface to report the Workstation ID in stead of the Revenue Center Number for each transaction. 



Note: 
If you check this, each workstation must be set up as a Revenue Center under Micros Definitions, and the list of valid revenue centers must actually be a list of valid workstation IDs.

Chop Rightmost 2 digits….
This option causes the rightmost 2 digits of the card number to be removed and the rest of the card number will be placed into Internal ID.   This is specifically for card systems that use the last 2 digits as the number of cards issued to the employee over their lifetime, where the rest of the number is the actual badge number.

Post Check Totals on Final Tender



If this is checked, then on Final Tender, if an Account Tender is present on the check with an account number, then the “totals” of the check will be posted to the transaction table for use with the Loyalty reporting.  Such totals will be independent of the actual charge amounts used in determining the balances

Acct Allowed Tmeds
This is a default list of micros tenders and default credit limits that is used to fill in the member/employee list of revenue centers when a new employee is added.


Acct Include RVC
This is a default list of revenue centers in which the employee may charge, and is used to fill in the member/employee’s list of revenue centers when a new employee is added.


GCInclude RVC
This is a default list of revenue centers in which the Value Card may be used, and is used to fill in the card’s list of revenue centers when a new card is added.

Configure->Special Options
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FnB Allowance / Minimums:

This feature is intended to provide information about monthly meal allowances and meal minimums.  Primarily, this is used to print the remaining and/or used “allowance amount” on the chits.  It is not used to stop payment.  Credit Limits should be used for that.  

FnB Amount
If this is set, then the “fnb allowances” printing module takes effect.

FnB Amount is Minimum
The amount is a monthly minimum amount.  Otherwise it is a monthly meal allowance (free meals amount).

Credit Limit is Number of Occupants



If the account is a Room number, then the FMB Amount is multiplied by the credit limit to determine the monthly amount for this room.


FnB Revenue Centers
The revenue centers in which the allowance/minimum used is calculated.  Meals outside these revenue centers are not included in the allowance total (e.g., if the Bar isn’t part of the free monthly food).

FnB Tenders
The Account Tenders that are associated with the FNB Allowance.  For example, The Meal Allowance Tender could be included, but the Guest Meals tender may not.

Photos:

If your members (accounts) have bitmap or jpeg photos available on an accessible server, then it may be possible to display them rather than the text list of names when doing an inquire or tender.   Bitmaps display more clearly and scale more effectively. Jpeg images will likely need to be scaled down for effective display on the workstations.  Typically, a camera system will create an image with dimensions like “34 inches by 28 inches”.  Jpeg images with dimensions closer to 6 or 8 inches will be most effectively displayed on the workstations.

Windows networking will be used to locate the photos.  Therefore, you will be required to attach a keyboard to every workstation using pictures to enter the network credentials when the first picture is looked up.  After that, the workstation should not need a keyboard.


Photo Path
The windows networking path from the Workstation to the location of the photos.

Photo Workstations
Only workstations in this list will attempt to use photos.

Auto Roll Over Tenders:

The “City” field of the Account Address is either the Standard Tender or the Assisted Tender.  When you use the Rollover inquire (8), it will first attempt to close up to the limit to that tender, then the rest will be closed to the Rollover Tender.
Configure->Account Tender Configuration

This screen allows entry of the Micros tenders that are “account” charges.  For example, those tenders that are billed through payroll or some other billing method at the end of a period.  


To add a tender, press the “+” key and then fill in the fields at the bottom. Press the Check mark when done.  Double Click a tender to edit the details.
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Edit Details:
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Account Name Text
Name that appears on the receipts. (Emp Charge)


Micros Tender
The Micros Tender Number.


Receipt Reset Dates
The starting date for the charge period total.  The chit that indicates Used or Available balance is derived by counting charges since this date and subtracting that from the account’s limit.  Generally this is reset via autosequence.  This would be the 1st of the month, the first day of a pay period, etc.

Card Number Start Position
Starting character in mag stripe that is number (1)


Card Number Length
Length of number on mag stripe (10)


Check Limit
Check the credit limit.


Check Active
Check whether the employee is active.


Trim Leading 0s
Remove leading 0s from the number read from a card

Allow Manual Entry
Check to allow manual entry of accounts (instead of a swipe).


Parse Manual Entries
Apply the Start Position/Length and the Trim Leading zeros settings to a manually entered number.

Use Chit
Print a chit or not when tenders are done.

Value Card Tender
Check if this is the value card tender.  This is included for future use in supporting multiple value card tenders.

Post Totals on Final Tmed
Check to post check totals to the account recorded in this tender when the check is closed.


Blind Tender
Check to skip account number validation.  This basically allows any number to be entered, and it will be stored on the check.  This is for tracking numbers/codes so that they can be used by the loyalty functionality.


Use Photos on Lookup
Check to have this tender use pictures, if pictures are enabled.  Inquires always use pictures if they are enabled.


Limit Sales Categories
If checked, then you can enter the Limit Sales Categories settings.  


Allow Tax
This tender will be able to pay for tax


Allow Svc
This tender will be able to pay for service charges


Allow AutoSvc
This tender will be able to pay for Autogratuities


Sales Itemizers
1 – 8 (on a 3700)



1 – 16(on a 9700)



Only sales itemizer totals in these sales itemizers can be paid for with this tender.


Notes:


This tender should be the 1st one used on the check for the proration to work properly.


Only 1 of this tender can be on the check in order for the proration to work properly.

 
This feature is intended for use in a situation where a Member will use this tender to pay for what is allowed as part of a monthly allowance, then pay the rest using some other payment method (or a different member tender).  It has not been tested widely beyond this situation.
Configure->Account Restrictions

This screen provides an alternative method of restricting various accounts to use only specific tenders.  While you can configure what tenders are allowed for individual accounts. Doing so can be difficult to manage, particularly with imported accounts.

The ranges of account numbers on this screen will be restricted to using the tenders entered with each range.  In this example, anyone with account numbers between 1000 and 4999 will only be allowed to use tender 101.  Any account outside of this range will be able to use all of the tenders in the Allowed Tenders list for their account.
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Configure->Residents Charge 


Resident (Medical Residents originally) charges are used to provide a fixed $ amount per “period” for free, while the remainder is automatically passed on to the employee’s charge account.  So, if each employee gets $3.50 per meal (breakfast, lunch, etc), then this could be configured to take the first $3.50 for an employee in each period and close it to resident charge.  Any amount over the $3.5 would automatically close to the employee’s charge account.
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Resident Tender
The Micros Resident Tender.


Resident Per Period Limit
Per Period max allowed in Resident Tender.


Overage Tender
The Micros tender used when the resident tender limit has been reached.  The remainder of the check will be closed to this tender using the same employee number.


Resident Periods:
Up to 5 periods can be defined.  They cannot span midnight.  If a resident charge is done and the current time is not in one of these periods, then the charge will not be allowed.  



Start:
The starting time



End
The ending time.



The format is HHMM in a 24 hour clock.  To decide if the charge is allowed, the interface does the following comparison:



If  ( now >= start and now <= end ) then use this period, and allow the charge.  

Configure->Stores Definition 


If you are using 1 database an several Micros Servers, each Micros server will be a “Store”.  Enter them here.
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Configure->Value Card Configuration



This screen is used to define basic Value Card parameters.
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Card Name Text
Name that appears on the receipts (e.g. Manager Card)


Micros Tender
The Micros Employee Tender.


Micros Add Service Charge
The Micros Service Charge for adding value to cards.


Micros Service Total
The Micros Send Order Tender.


GC Void Reason Code
If no void reasons are used, enter 0.  Otherwise, enter the void reason code to use when voiding an Add Value function.


Res Has @VOIDSTATUS
If your version of RES (3700) has the @VOIDSTATUS system variable, check this.  Otherwise, uncheck this.  Refer to the Micros SP and HF docs to determine whether or not your HF / SP levels have this function.  Or, try it, and if you get an “ISL Error” when you press the Micros Void key followed by the Add Value key, you don’t have it!


Card Number Start Position
Starting character in the mag stripe that is the 1st character of the employee number

Card Number Length
Length of employee number on mag stripe recommended to be less than 10 to improve performance.

Allow Manual Entry
Set to 1 to allow manual entry of card numbers  (instead of a swipe).

Reports


General


Reports are available from the reports progrsm ‘CSG_Reports”. 


At the time of this manual, reports are a work in progress and more reports may be added and some removed.  In addition, reports are possible by using MS Access, Crystal Reports, or by using SQL to import data from the database directly into Excel, etc.

The main report screen is shown here:
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Selected Printer: 
Use File->PrinterSelection to choose a default printer for this application.
Start Date:
Select the beginning date to be covered by the report.

Store:
If you have multiple Micros Servers operating from the same database, use this to select the specific server to report, or All for all transactions.

Revenue Center:
If Use this to select the specific revenue center to report, or All for all transactions.

Number of Days:
Number of days, including the start date, to include in the report.

Account Range / Card Range:



Depending on the report, you may be able to enter a range of accounts or card numbers.  If you only enter the starting number, it will be assumed that it is also the ending number.  No numbers entered is assumed to include all cards/accounts.

Account Charge Detail Tenders:


Select the Micros Payment type to include.  The Names on this form will be taken from the Name fields for the particular payment types in “csg_members”.  To include other micros tenders that are not Account 1, Account 2, Resident, or Value Cards, enter the Micros tender number in the Other Tender field ad check the box.

Excel:
If you have MS Excel 2000 or later installed on the PC from which this instance of the reports program is running, you can use this button to create a spreadsheet of the report data.  

Normally, this button would be used on a desktop PC that has Excel, and also runs this application.
Press either View or Print to view or print a report.
Charge Reports


The Charge report is a general report that presents a detailed report of “account” and/or card charges by Account.
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Card Reports


Card reports are specific to Value Cards and present a variety of information about cards.  Select the report type and click either View or Report.
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Value Card Charges by Account will present charges within a range of dates.  

Value Card History will present a cards entire transaction history from initial balance thru now.  This report will present the full history of any card that has had transactions within the time frame entered.

Misc Reports

Miscellaneous reports are essentially card and account lists.  Pick a report and press View or Print.
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Loyalty Reports

These are reports that present the spending totals for accounts.  These are based on entire check totals, rather than specific amounts paid to an account charge.
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File Menu


Printer Select
Select the default printer for reports.


Save Local Printer
Saves the printer selection to the local hard drive.


Quit
Quit.  Note that some things are saved within the application, and others are not.  Most “parameters” will not be saved until “Save” is used.  Card and account info is saved at various points within their forms.

BPOS Members SIM Connector
The program   csg_members5\BPOSMembersConnector.exe is used provide SIM database access for this interface. It requires .Net 1.1 (the 3700 required version).  It is installed from the csg_members_batch.exe program.

Once installed, you can go to the Services function and start/stop the service which will be called:


BPOS Members SIM Connector
Parameters for this program are in the text file described below.  You should be able to configure this from the csg_members.exe program, but you can also edit some things manually.

\csg_members5\csg_odbc.dat

log_file,sim_odbc.log

write_log,2

alias,micros

dsn,DSN=micros;UID=custom

user,custom

password,†rœ
±S

micros_port,5008

rotate_log_days,1

rotate_log_hour,3

db_type,2

license,4780c5_90`\+
log_file: 
This is the name of the log file

write_log;
0 = no, 1 – 9 = verbosity
dsn
On 8700 and 9700:

DSN=bposmembers.  bposmembers is the ODBC system dsn for the database. 
On 3700:

DSN=micros;UID=custom.  Don’t change this. 

Alias

On 8700 and 9700, Alias is bposmembers.
On 3700, Alias is micros

User
The database user for this app.  Let the csg_members application set this for you.

Password
Encrypted password. Let the csg_members application set this for you


Micros port
Micros Interface Port defined in the configurator


Db_type

0 = MS Sql, 2 = Sybase
License
License code for the application.
Batch Processing

Overview

End of day/period processing should be done through “csg_members_batch.exe”.  This utility is intended as a batch processing program to be executed via autosequence.  It can be run interactively.

This utility is also where import and export configurations are defined.  
Normally, all options for this program are called from either:


Csg_members_eod.bat

// End of day stuff


Csg_members_eom.bat

// end of pay period stuff.

And these files need to be adapted to your installation.

You are free to add more.

Main Screen
Without command lines, you get this screen:
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This application reads the database login information from csg_odbc.dat.  If this information is correct, then the Database Information should say “connected”.  

Top Button Row:

Exports:
This is used to define Export Definitions.  There can be many, and each is saved in a separate file.
Imports:
This is used to define Import Definitions.  There can be many, and each is saved in a separate file.

Run Section:

Import / Export Definition File:

The definition file to execute.

Run


Do the import or export.

To manually start an import or export, select the definition file, then press Run.  

Import Definition Screen
Pressing the Imports icon produces the following screen:


Select a definition file.  If you are creating a new file, enter the new name in the selection window, and press Open:
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The main import screen is defined below:
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Import Data File: 


file that contains data for import.  Either a full path name, or relative name to this program.  For example “xfer\MyImpFile.txt” would find the file in  “\csg_members6\xfer\MyImpFile.txt”

General Format: 


Fixed Length / Delimited



Check one. If delimited, then the Field Separator box is available.


Field Separator



Check one. “Other” requires a 1 character separator be entered.

Skip 1st Row: 
Check this if the 1st row contains headings or titles.


Value Cards: 
Check this if the file contains value card info


Deactivate before import: 
Check this to deactivate all accounts, then reactivate the accounts that are in the import file.  This should almost always be checked.


Update Balances Only: 
For Value Cards, just change the balances, done edit other information.


Trim Leading 0s:

Trim Leading 0s from the numbers in the import file before inserting into the database.


Palmetto ID scheme
Check this if you are a Palmetto Health hospital.

Import File Fields: 


The grey list contains the fields in the database that are available for import.  You define which fields from the import file are stuffed into these available database fields.  

1.
Click in the row you wish to define. 


2.
Press the “type” button: Field Value, Formula, Constant.  


3.
If the import file is Fixed Length, then enter the Start position and length from the import file.  If you file is delimited, enter the field number that should be placed into this database field.


4.
If the Type you chose was “Formula”, you should enter the formula:



[f]  

= The value in this field from the import file.



“Hello There”
= The text “Hello There”



[f] * 2

= The value of the field in the import file times 2.



Etc.


5.
Repeat this for the fields you wish to import.



Then, press the “Save” button to save this definition file.  



6.
Testing: You can press the “Test” button, which will read and process your import definition and file, and it will show the results in the window:  This won’t import the data, but it will show what it would look like after the import.
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To run the import, save this import definition, then return to the Run screen and run this import definition.

Export Definition Screen
Pressing the Imports icon produces the following screen:


Select a definition file.  If you are creating a new file, enter the new name in the selection window, and press Open:
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The main export screen is defined below:
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Export Data File: 


file that will be created that contains exported data.  Either a full path name, or relative name to this program.  For example “xfer\MyExpFile.txt” would find the file in  “\csg_members6\xfer\MyExpFile.txt”

General Format: 


Fixed Length / Delimited



Check one. If delimited, then the Field Separator box is available.


Field Separator

Check one. “Other” requires a 1 character separator be entered.

Output Sums: 
If checked, then there will generally be 1 record per Account, which contains the sum of the numeric fields over the time period.  Unchecked, the file will contain 1 row per charge.

Number or Days: 
Default number of days to export for.

Monthly: 
Check this to use a Monthly file. (this will be “month to date”)

Skip Tenders: 
Skip these Tenders
Output Data Fields: 


The grey list contains the fields in the database that are available for export.  You define which fields are placed into the export file.  

1.
Click in the row you wish to define. 


2.
Press the “type” button: Field Value, Formula(integer or decimal). Integer formulae will force the output to be an integer (2.00 would be 2).  Decimal formulae will produce decimal numbers (2.24, 12.00)


3.
Toggle Quotes will make the output data surrounded by quotes (or not).


4.
If the Type you chose was “Formula”, you should enter the formula:



[Some Field]  

= The value in this field from the database



“Hello There”

= The text “Hello There”



Int( [si_1] * 100 )
= The integer portion of the value of the field “si_1” (sales itemizer 1) in the import file times, times 100.  That is, 2.5 would be exported as Int(2.5*100) = 2500



Etc.



Be careful about division to avoid division by 0.


5.
Repeat this for the fields you wish to import.



Then, press the “Save” button to save this definition file.  



6.
Testing: You can press the “Test” button, which will read and process your export definition and file, and it will show the results in the window:  This won’t import the data, but it will show what it would look like after the import.
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To run the import, save this import definition, then return to the Run screen and run this import definition.

Formulae: 

 
Basic Formulae are available.  IIF and some other formula commands are not currently available, but can be purchased for an additional fee.  Below is a short list of formula commands, but this is not exhaustive.  Use the Help buttons for a complete list (the ? button).
Symbol    Description                Example
!         Factorial                  5! = 120
^         Raised to the power of     4 ^ 5 = 1024
*         Multiply by                3 * 6 = 18
/         Divide by                  9 / 2 = 4.5
\         Integer divide by          9 \ 2 = 4
mod       Modulo (remainder)         7 mod 4 = 3
+         Add                        1 + 1 = 2
-         Subtract                   9 - 5 = 4
-         Unary negation             -(5+4) = -9
+         Concatenate                'Zeb' + 'ra' = 'Zebra'
>         Greater than (numeric)     9 > 2 = -1
<         Less than (numeric)        7 < 4 = 0
==        Equal test (numeric)       5 == 4 = 0
>=        Greater or equal (numeric) 3 >= 3 = -1
<=        Less or equal (numeric)    #h3E <= 9 = 0
<>        Not equal (numeric)        #b10101 <> 20 = -1
>         Greater than (string)      'This' > 'That' = -1
<         Less than (string)         'This' < 'That' = 0
==        Equal test (string)        'A' == 'B' = 0
>=        Greater or equal (string)  'Zeb' >= 'Zebra' = 0
<=        Less or equal (string)     'Zeb' <= 'Zebra' = -1
<>        Not equal (string)         'X' <> 'Y' = -1
Command Line Arguments
Csg_members_batch.exe <Args> …


-y




Use Yesterday as the business date


-IF<FileName> 



Import transactions


-EF<FileName>



Export transactions

RESET_RECEIPT    NNN

Reset credit limit/receipt period date for tender NNN

PURGE




Purge old transactions


RESET_BD
Resets the csg_members business date.  Should be done at the same time as the Micros business date rolls over.  This is generally not required anymore.

RESET_BALANCE   NNN.NN
Set the Value Cards to all have a particular balance ($NNN.NN).


Examples:

csg_members_batch –IFmydeffile.txt



will import using the definition file mydeffile.txt

csg_members_batch –EXcharges_def.txt


will export using the definition file charges_def.txt



csg_members_batch RESET_RECEIPT 101

csg_members_batch RESET_RECEIPT 102


will reset the receipt_period_start date for Account Tender 101 and 102 to be the current date.  This effectively resets the credit limits to start over now.


csg_members_batch RESET_BALANCE 100.00


will reset the balance on EVERY value card to 100.00.


IMPORT


An import will read the import definition file, defined using interactive mode, and based on the definition, will import/update the data in the custom table “csg_members”.   

The option “deactivate before import” will cause all accounts to be set as Inactive.  Then, during the import, accounts that are in the import file will be reset to Active, and the basic import data will be updated.  New accounts will be created and set to Active.

The Tenders and Balances available to an account will default to the “System Defaults” settings in Csg_members.exe.  


In this version, it is not possible to import specific tenders and credit limits.

Before running the import process, the bat file:  “before_import.bat” is executed.  Use this to launch custom programs that pre-process data. For example, you may need to run a custom application to merge several employee files into a single file that can be used by the import process.

EXPORT


An export will read the export definition file, defined using interactive mode, and based on the definition, will export the data from table “csg_member_trans”.   

After the data has been exported, the bat file “after_export.bat” is run.  Use this to launch any custom programs you may need to further process the exported data.  For example, if you needed to insert the Julian Date Number of the transaction dates into the exported employee payroll deduction file, you would need an external program.
Import Export

Special Situations

And Configurations

Tax Exempt

You can have an Account Tender do Tax Exemption as follows:

1.
Create a “Tax Exempt Macro”:


step 1
Tax Exempt


step 2
Tender Media -> Account Tender

2.
Create a “CSG Tax Exempt” Key that calls this macro

3
When this key is used, the check becomes tax exempt, then, if the Account Tender succeeds, the check stays tax exempt.  If the Account Tender fails (e.g., invalid member, etc), then the tax exempt turns off.

Loyalty – Tracking Members Spending
If you want to track the spending totals for members, then you can set up the following:
1.
Enter an Account for each member
2.
In the CSG Members application, select the Configuration->System Defaults menu option
3
Check the box “Post Check Totals in Final Tender”

4.
Create a Micros Tender that will always be $0.00, and will be used to capture the member number on a check.  



No Reference Required



No Amount Required



No Assume Paid In Full



No Charge Tips, don’t post to gross rec or charge rec.



Link it to this interface



3700 – Key Code = Object Number

5.
Add this tender to the CSG Members Program under Configuration->Account Tender Configuration.



Do Not Check Limit



Do not limit sales categories



Not a Blind Tender



Not a value card tender


Add this tender to the Configuration->Micros Definitions section

6.
Add the tender from 5 onto a touchscreen and call it “Member Swipe” or something helpful.


When the user presses this touchscreen button, they will be prompted to enter the member or account number.  If the member exists, then the number will be saved on the check.


When the check is Final Tendered (Closed), the check totals will be written to the csg_member_trans database, using tender number 0.  The Itemizer totals, tax totals, service charge totals, etc. will reflect the check totals.  The Loyalty Reports can then be used to provide reports.


The last Account entered using the Member Swipe Button will be the member to which the totals are posted.  Only 1 loyalty member can be use per check.
Select your  9700 Server .





Available Tenders for the report. Select at least 1.  (These will be your tenders)





Create or Edit Import / Export Definitions





Run (import or export)





Revenue Centers in which this card may be used.





Allowed Charge Tenders, and the credit limit for that tender.





Revenue Centers in which this Account can charge.





Launch Excel with the data





Report Type:


Charge Detail


Value Card Usage


Miscellaneous


Loyalty








Definition File to Run





Revenue Centers


Tenders


Property Name


Sales Itemizers





View / Print the report





Available reports in this group





+ to add a new record


- to delete a record


Check Mark to save
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